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Mastering MathML Content Markup 
 
Presentation elements describe visual two-dimensional hierarchical forms and thus give 

more or less precise instructions how to render and how edit mathematical constructs. Content 
Markup closely follows the semantic structure of the mathematical objects. This is quite the 
challenging approach to coding mathematics for such a WYSIWYG-style mathematical editor, 
as Formulator 3.7 MathML Weaver. 

As an answer to this problem MathML Weaver implements a technology of internal 
wrapping of Content Markup expressions in Presentation Markup nodes. The main tool for this 
is an empty frame element that encodes a new hierarchical relations inside of Content Markup 
expression and carries all the specific information about final names and values of tags and 
attributes. This allows to edit Content Markup expressions in WYSIWYG-style, but at the same 
to establish explicit connections between mathematical structures and their mathematical 
meanings. 

Please note that, as a rule, a user should not care about wrapping of Content Markup 
expressions in Presentation Markup nodes. From the point of view of end-user, there is just a 
way in MathML Weaver to insert and to edit visually a semantic kind of MathML notation . The 
only reason why we raise this question in the manual is that bearing in mind of such an 
peculiarity of the Content Markup editing implementation can be useful for understanding of 
the behavior of MathML Weaver in some complicated cases. 

 
General Principles of Editing and Navigation 
 
MathML Weaver proposes two ways to create Content Markup elements. The first is 

most general, since it supposes to make use of mathematical toolbars: 
 

 
 
A group of Content mathematical templates comprises: 
 token elements 
 basic content elements 
 piecewise declaration templates 
 arithmetic operators 
 algebra operators 
 logic operators 
 maximum and minimum templates 
 relations templates 
 calculus and vector calculus templates 
 theory of sets templates 
 sequences and series templates 
 common trigonometric functions 
 common hyperbolic functions 
 common exponential functions 
 statistics templates 
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 linear algebra templates 
 semantics templates 
 constant and symbol elements 
 qualifier elements templates 
 
The second way to insert Content Markup elements is connected with an option to 

switch input between Content and Presentation MathML input modes (the last one is used by 
default): 

 

 
 

 
 
 Selecting Content MathML Input Mode leads to inserting of Content MathML 

mathematical templates when a user presses a sign of the corresponding operation. E.g., 
pressing „+‟ in the Content MathML Input Mode inserts a mathematical template ▓+▓ for the 
<apply> element with the operator element <plus/>. The next example shows how to work 
with this mode in more details. 

 
1. After switching to the Content MathML Input Mode type ‟+‟ sign (make sure that 

Status Icon in the right bottom corner of MathML Weaver indicates ). We now see the 
<apply> element inserted. Then we can use the “Show Nesting” command and navigation 
arrows to investigate how this Content Markup element is composed. 

 

 
 
A grey rectangle around the ▓+▓ form and tips in the status bar suggests that in the 

document there is one frame node, marked as an “apply” element and internally encoded as an 
additional nesting “mrow” element. 

After pressing the Right arrow we consequently get to the input slots of this “apply” 
form. ‟+‟ sign cannot be edited on this stage, since it is an integral part of the expression. For the 
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sake of flexibility the type of operation still can be easily changed using the “MathML Tree” 
page: 

 

 
 

 
 
2. Now we can enter arguments of the just created “apply” element. The most important 

thing about input slots of this visual form is that their kinds can be automatically detected by 
MathML Weaver after a user types some text or utilizes Formulator‟s mathematical toolbars. 

Initially, these input slots don‟t have any predefined kind (associated Content or 
Presentation Markup element). It can be easily discovered if we look on the navigation 
information bar; there is a record for the parent node, but the current node record is undefined 
yet. 

 

 
 
 
Type character „a‟ in the first slot, press the Right arrow and type „2‟ in the second slot: 
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Note that on this stage „a‟ and „2‟ are still marked as presentation elements (“mi”, ”mn”). 

They become Content elements only after they will be converted from the internal document 
representation to MathML 2.0 text. 

Switch to the “MathML Tree” page and make certain that the “apply” element is created 
correctly. 

 

 
 
Now switch back to the “Expression” page and exchange „a‟ and „2‟ in their input slots. 
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The “MathML Tree” page shows that input slots still work as automatically detected by 
their content areas, because the first slot now turns to be ”cn” element and the second slot 
became the ”ci” element. 

 

 
 
3. This smart behavior of the input slots of the “apply” form lasts for all the time of 

WYSIWYG-style editing, but stops when a user manually interferes in the editing by means of 
the “MathML Tree” or “MathML Text” page. To see this, switch to the “MathML Tree” and 
change type of the operator from <plus/> to <minus/>: 

 

 
 

 
 
At first glance nothing changed, but take a look to the navigation information bar (red 

circled area). Now We have a rigid Content Markup structure, composed of the “apply” 
element with a leaf of the “ci” element. The internal presentation of the “ci” element is formed 
of the “mi” element, but it is of less importance, since in the MathML 2.0 text there will be no 
internal presentation remains. 
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To make sure that a new structure of the expression is fixed try to repeat our trick with 
exchanging „a‟ and „2‟ in their input slots. 

 

 
 

 
 
Now „a‟ is considered as a number token element “cn” and „2‟ is considered as an 

identifier element “ci”, because in the rigid structured document input slots have already known 
their kind of Content MathML elements and no automatically detection was provided. 

 
In this example we show another typical feature of the way that MathML Weaver deals 

with Content Markup. Since „a‟ is situated in the “cn” element, it should not be rendered as 
italic. But MathML Weaver doesn‟t interfere into a user‟s work in such a case, but proposes 
instead a short way to bring the formula‟s image to conformity with its semantics. Choose the 
“Refresh All Through MathML” command from the View menu and see how the entire look of 
the mathematical formula is changed. 
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3. Input slots of the created “apply” form can be filled as well with more complicated 
expressions than tokens. See, for example, how to create mathematical expression with several 
arithmetical operations. 

 
Press the „+‟ sign. 
 

 
 
Press the „-‟ sign. 
 

 
 
Press „1‟, the Right arrow, „2‟. 
 

 
 
Press the Right arrow. Now be careful with editing actions, because dashed selection 

around 1 – 2 form indicates that we now on the hierarchical level of the “apply” element with 
<minus/> operator inside. 

 

 
 
To continue editing the formula we need to place cursor to an empty input slot on the 

right side of the formula, so, just press the Right arrow once more. 
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Press „*‟. 
 

 
 
Press „3‟, the Right arrow, „4‟. 
 

 
 
The needed formula is created but lacks of proper appearance, because MathML Weaver 

has no chance yet to apply its precedence rules and to calculate how to draw this Content 
Markup formula. Choose the “Refresh All Through MathML” command and see how the image 
of the mathematical formula is changed. 

 

 

 
After we have created a mathematical formula we can check how it is encoded in 

MathML 2.0 format using the “MathML Tree” or “MathML Text” pages. 
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4. Navigation through the newly created formula is not absolutely evident until we think 

about hierarchical structure of the Content Markup expression. Choose the “Show Nesting” 
command (by pressing Ctrl+Shift+N or from the “View” menu); then choose a new greater 
scale factor by pressing Ctrl+5 or from the “Zoom” submenu of the “View” menu. 

 

 
 
Now we can clearly see that the structure of the expression is not simple and we cannot 

expect the navigation to be as plain as in the Presentation Markup case. The higher level 
“apply” element has two child “apply” elements, and each of them in its turn has child leafs, 
encoded with token elements. 
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Press the mouse button on the right of the formula. This will place the cursor in the 
outermost right position available for editing. 

 

 
 
Press the Left arrow. The cursor is now in a position for editing an input slot that 

currently has „4‟ in it. See the navigation information bar to make sure of this. Note that cursor 
height is changed also according to the current inner level of hierarchy. 

 

 
 
Press „0‟ to edit the last argument of the expression. 
 

 
 
Press the Left arrow three times. We now again on the level of the <times/> “apply” 

element. In this position we could delete the last argument after pressing Delete button two 
times. The first pressure would select the entire input slot and mark it with black. The second 
pressure would confirm deletion. 

In order to get back to the higher level of the <plus/> “apply” element we need now 5 
times pressing of the Left arrow. By each pressing we go through different levels of the formula 
structure, where each level propose its own editing facilities. Imagine that we are navigating 
through the tree of Content Markup elements and this procedure becomes evident. 

See how the navigation information bar helps to understand which level of the formula 
structure is currently available for editing. 
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Press the Left arrow and the Backspace button. 
 

 
 
(1 – 2) form is marked for deletion. Press the Backspace button once more time. 
 

 
 
Now type number 100 and by switching to the “MathML Text” see how MathML 

Weaver automatically detected that while a user is situated inside of the Content Markup 
expression then the Content token element is needed. 
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Token Elements: externally defined symbol (csymbol) 
 
Content expression trees are built up starting from token elements. Numbers and 

symbols are marked by the “cn” and “ci” elements; the “csymbol” element allows to create an 
element whose semantics are externally defined. 

Content Markup token elements are available via  toolbar: 

 

 
 
As we can see from this figure, MathML Weaver provide several buttons for a token 

element to account for existing options of base, type, etc. A button with „…‟ sign on its image 
leads to a dialog requesting some context dependent attributes of the newly created expression 
(e.g., type of an identifier). 

 
1. The simplest case of the Content token element is presented by “csymbol”. When a 

user presses  icon, the current empty slot is not altered visually, but the navigation 

information on the status bar helps to understand that we have already started to build a 
Content expression tree. The next tree figures shows this in details. 
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Now all that we type in the current empty slot will be interpreted as a content of the 

“csymbol” element: 
 

 
 

 
 
2. It is worth noting that this just created Content expression can be supplied with all the 

need attributes on the page of “MathML Tree”. The next figure shows how to turn this 
expression into the example 4.4.1.3.3 from the W3C MathML Recommendation (reference to 
human readable text description of Boltzmann's constant). 

 

 
 
3. Another important feature of the inserted visual forms for Content Markup in 

MathML Weaver is that they also can carry Presentation Markup. For example, if we use a set of 
Presentation toolbars we can easily create another example from the section 4.4.1.3.3 of the W3C 
MathML Recommendation (reference to OpenMath formal syntax definition of Bessel function): 
 
<!-- reference to OpenMath formal syntax definition of Bessel function --> 

<apply> 

  <csymbol encoding="OpenMath"  

    definitionURL="http://www.openmath.org/cd/hypergeo2#BesselJ"> 

    <msub><mi>J</mi><mn>0</mn></msub> 

  </csymbol> 

  <ci>y</ci> 
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</apply> 

 

Press the  button on the Content toolbar set to get access to the group of “apply” 

elements of different form. Choose the first button. 
 

 
 
This will insert an “apply” element with one argument in its functional form. 
 

 
 
Now insert the “csymbol” element in the first input slot of the “apply” element. 
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Using the Presentation toolbars set build up contents of the “csymbol” element: 
<msub><mi>J</mi><mn>0</mn></msub>  (J0). 

 

 
 

 

 
 
Navigate to the second input slot of the “apply” element and press „y‟. This will fill the 

argument of the “apply” element with <ci>y</ci> content. 
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Now switch to the “MathML Tree” to add two attributes to the “csymbol” element. In 
order to do this click on the right side of the document (“Property-Value” dialog) and press the 
Insert button. We now see that an empty attribute record is added. 

 

 
 
Using drop-down lists create “encoding” and “definitionURL” attributes. 
 

 
 
Check the results on the “Expression” and “MathML Text” pages. 
 

 
 

 
 
Token Elements: numbers (cn) and identifiers (ci) 
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There are several attributes modifying Content Markup semantics for token elements. 
Thus the “base” attribute indicates numerical base of the number; the “type” attribute indicates 
type of the number or identifier. Moreover, different types of numbers will be rendered in a 
different way and even appearance of identifiers can be altered by changing the “type” 
attribute. 

In order to visually support these requirements, Formulator 3.7 MathML Weaver 
proposes several ways to input Content Markup token elements: namely, a user can choose a 
button representing the needed type of a number from the toolbar or make some alterations in 
the attribute values via the “MathML Tree” page or by using corresponding property dialogs 

for buttons  and : 

 

  
 
1. The next example shows how to create a simple identifier token element and how to 

change its appearance by editing the “type” attribute. 

Insert the “ci” element by pressing the  button. 

 

 
 
As it is shown on the next figure, the “ci” element appears as an empty slot and the 

navigation bar information makes sure that it is inserted. 
 

 
 
Now type an identifier in the current input slot. Note that the context of the “ci” element 

is one of three cases where presentation markup may appear in content markup properly. So, 
not only plain text can be typed into the “ci” input slot, but also some kind of presentation 
markup tree. 
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According to the default value of the “type” attribute of the “ci” element (unspecified 

type), contents of the “ci” element are represented as if it were contents of a “mi” element (italic 
style). 

Now change the current page of MathML Weaver and add the “type” attribute into the 
“ci” node. Then choose the “matrix” value from the list of known identifier‟s types. 

 

 
 
Switch back to the “Expression” page and see how rendering of the “ci” element is 

changed. Now A is bold according to the typographical rules of representing the “matrix” type. 
 

 
 
As in the case of the “csymbol” element, Content Markup identifiers can carry 

Presentation Markup. For example, if we use a set of Presentation toolbars we can create an 
example from the section 4.4.1.2.2 of the W3C MathML Recommendation: 

 
<ci> 

  <msub> 

    <mi>x</mi> 

    <mi>i</mi> 

  </msub> 

</ci> 

 
Insert the “ci” element. 
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Use the Presentation toolbar to insert Subscript node and fill it with xi expression. 
 

 
 

 
 
See results on the “MathML Text” page. 
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2. The next example shows how to create a simple number token element and how to 
control its appearance and semantics by altering “type” and “base” attributes. 

Insert the “cn” element by pressing the  button. Then the initial property dialog for 

the “cn” element will be shown. 
 

 
 
Choose the “integer” value in the “type” drop-down list and 5 as a base of a number. 

This feature lets creating numbers of different numerical bases. 
 

 
 
A user can control number‟s type not only via different values proposed by the initial 

property dialog (“rational”, “complex-cartesian”, “complex-polar”), but also with the help other 

available buttons of the  toolbar. 

For example, rational numbers can be created by pressing the  button if the 

“rational” type is selected afterwards from the initial property dialog or at once with the  

button. 
 

Press the  button and select the “rational” type. 

 

 
 
Fill numerator and denominator with the numerical values. 
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Select the created rational number (with Shift + arrow keys or with mouse) and click on 

the  button. The pane of Arithmetic Operators of the Content Markup is now available. After 

pressing on one of the buttons representing the “apply” element with one and more arguments 
the current selection will be considered as the first argument of this “apply” element. 

 

 
 

Let‟s press on the  button and see how the structure of the built MathML tree is 

changed. The figure suggests that the  <apply><plus/>…</apply> pattern is inserted and the 
rational “cn” element is the first argument of this operation. 
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To fill the second input slot, navigate to it with the Right arrow and press the  button 

of the  toolbar. This will insert another rational number without additional dialogs. 

 

 
 
Compare results on different pages of MathML Weaver (“Expression”, “MathML Tree”, 

“MathML Test”). 
 

 
 

 
 

 
 
Basic Content Elements: apply 
 
The “apply” element of the Content Markup allows a function or operator to be applied 

to its arguments. It is the basic element in a sense that the overwhelming majority of 
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expressions in MathML content markup is carried out by applying operators or functions to 
arguments. 

The toolbar of basic content elements  in MathML Weaver contains several groups of 

buttons for creating different forms of the “apply” element and some related to this element 
concepts: 

 

 
 
The first 4 buttons in the toolbar are responsible for the “apply” element itself: 1, 2, 3, and 

many-arguments forms. Please note, that these buttons represents the most general, functional 
form of the “apply” element appearance. Theoretically we can use these buttons for some other 
purpose, e.g., for arithmetic operators applying, but since there is a traditional infix form of 
rendering for arithmetic operators, such way of editing MathML content markup is not 
recommended. The next example shows this and others features of work with the “apply” 
element. 

 
1. Insert sin(x) expression. 
 

Press the  button; type “sin” in the first and “x” in the second input slot. 
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The rendering of this MathML fragment is not finished; to make it correct use the 

“Refresh All Through MathML” command from the “View” menu. This helps MathML Weaver 
to find the meaning of the entered text and to render it according to the mathematics 
representation rules. 

 

 
 
We did need such an additional action, because the most general form of the “apply” 

element was used. Normally, it is quite enough for users to have just special toolbars with 
common functions and operators. The previous example in that case would be more simple, as 
the next figures suggest. 

 

Press the  button of the common trigonometric functions toolbar ( ) and type “x” 

in the input slot. 
 

 
 

 
 
We have the same MathML tree for sin(x) as earlier, but now it was much faster. 
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There is one more way to deal with this example, but it is similar to the first case and is 

shown here only for the sake of completeness. The only distinction is that we can not just type 

the “sin” value into the input slot, but press the corresponding  button from the common 

trigonometric functions toolbar ( ). Then MathML Weaver will know about the special (plain, 

not italic) rendering of the first argument of the “apply” element, but still we should use the 
“Refresh All Through MathML” command from the “View” menu to help MathML Weaver 
understand that enclosing the “x” text in brackets is not needed: 

 

 
 
2. Insert a function of four arguments. 
 

Press the  button; fill the needed number of arguments in the shown dialog and see 

the newly created visual representation of the “apply” element. 
 

 
 

 
 
Now this form can be filled with other elements of the MathML content markup. 
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3. Create an arithmetic expression. 
 
The easy way is to use the corresponding toolbar and special buttons: 
 

 
 

 

 
 
There is also a more long way to create this form by means of the “Basic Content 

Elements” toolbar. 
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Type the operator „+‟ and values into input slots as if they represent the functional (in 

contrast to infix) notation. 
 

 
 
The structure of the MathML tree is already built up, but the rendering will become 

correct after refreshing the text by means of the “Refresh All Through MathML” command. 
 

 
 

 
 

 
 
Basic Content Elements: functions and operators 
 
1. Create the image of a given function, which is the set of values taken by the function 

(4.4.2.14.2 example from the W3C MathML Recommendation): 
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<apply> 

  <eq/> 

  <apply><image/> 

    <sin/> 

  </apply> 

  <interval> 

    <cn>-1</cn> 

    <cn> 1</cn> 

  </interval> 

</apply> 
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There comes a time when we should recall the difference between Presentation and 

Content markups. If we just type any text into the first and the second slot, MathML Weaver 
consider this as if we want to create some presentation for arguments of the “interval” element. 
But it is not true, since we are going to create content markup number elements there. So, now 
be careful, MathML Weaver will correctly detect the element of the content markup only if we 
type into these slots valid numeric constants. 

 

 
 



Mastering MathML Content Markup  http://www.mmlsoft.com  
 

 33 

 
 

 
 
2. Create the inverse element in order to construct a generic expression for the functional 

inverse of that function (4.4.2.5.2 example from the W3C MathML Recommendation): 
 

<apply> 

  <inverse/> 

  <ci> f </ci> 

</apply> 
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Type “f” into the input slot and see the structure of the MathML tree using nesting 

feature (Ctrl+Shift+N) and larger zoom (Ctrl+5). 
 

 
 
See results on the “MathML Tree” page. 
 

 
 
 

<apply> 

  <apply><inverse/> 

    <ci type="matrix"> a </ci> 

  </apply> 

  <ci> A </ci> 

</apply> 
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3. Create the lambda element that is used to construct a user-defined function from an 

expression, bound variables, and qualifiers (4.4.2.9.2 examples from the W3C MathML 
Recommendation): 

 
<lambda> 

  <bvar><ci> x </ci></bvar> 

  <apply><sin/> 

    <apply> 

      <plus/> 

      <ci> x </ci> 

      <cn> 1 </cn> 

    </apply> 

  </apply> 

</lambda> 

 
 

 
 
The first input slot is for the “bvar” element; type “x” text into it and it will be detected 

as a “ci” element when converting to MathML. 
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Now navigate to the second input slot (press the Right arrow) and insert a new visual 

form for editing sin(…) expression. 
 

 
 

 
 
Now insert the “apply” element for the <plus/> operator. Please note that we cannot just 

type „+‟ sign, because the current input mode is Presentation MathML (icon  in the right side 
of the Status Bar). 
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Type “x” and “1” into input slots. The results are shown on the next two figures. 
 

 
 

 
 

 
 
Basic Content Elements: invisible and transparent elements 
 
This section describes how to work with invisible and transparent MathML nodes: 

“declare” and “condition” elements of the content markup. 
 
Working with the “declare” element asks for additional actions, because according to the 

W3C MathML Recommendation it should not be directly rendered. Thus the “declare” element 
is considered as invisible and is rendered in two cases only: 
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a) just after insertion of this element from the mathematical toolbar of MathML Weaver 

( ); 

b) if the option “show invisible elements” is turned on (the green icon  in the right 
corner of the Status Bar). 

Additionally there is a limitation while using the “declare” element: MathML Weaver 
cannot hold a document that has no other elements except of the “declare”. This means that 
when a user tries to save the following example without any additional MathML elements, then 
an empty document will be created. This known limitation of MathML Weaver relates to the 
specific rendering requirements of the “declare” element and the point that the presence of this 
element makes a sense only when other elements of the document refers to this declaration. 

 
1. In order to demonstrate how to work with the “declare” element let‟s create a MathML 

tree for the following example from the W3C MathML Recommendation (4.4.2.8.1) 
 

<declare type="vector"> 

  <ci> V </ci> 

  <vector> 

    <cn> 1 </cn><cn> 2 </cn><cn> 3 </cn> 

  </vector> 

</declare> 

 

 
 
Please note that currently rendering of invisible elements is turned off ( ). 
 

 
 
A dialog is shown to initially tune attributes of the “declare” element. Select the “vector” 

in the “Type” drop-down list. The next two attributes (“nargs”, “occurrence”) can be leave as 
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they are, without editing. The check-box to the bottom of the dialog asks whether the “declare” 
element contains a constructor initializing the variable. 

 

 
 

 
 
Type “V” into the first input slot; place the cursor into the second input slot and press the 

button for the “vector” element insertion. 
 

 
 

 



Mastering MathML Content Markup  http://www.mmlsoft.com  
 

 41 

 
Type values of the vector into three input slots. 
 

 
 
See the results. 
 

 
 
Now do a inessential editing of the MathML text (for example, just press a space 

somewhere between tags) and get back to the “Expression” page. We see an empty body of the 
document, because the “declare” element is not rendered normally and the option “show 
invisible elements” is turned off currently. About presence of the just created “declare” element 
indicates only the navigation information bar and absence of the dashed line around an empty 
input slot (it is shown only when the line of a document contains no elements). 

 

 
 
Check the option “show invisible elements” from the “Display Content MathML 

Elements” submenu of the “Option” menu. We still can‟t see the “declare” element, but the icon 
 suggests that the action was successful and the icon  prompts to the need of refreshing the 

document through MathML (the “Refresh All Through MathML” command from the “View” 
menu). 
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After refreshing the document rendering we see the “declare” element again, because the 

mode of invisible elements rendering is now turned on. 
 

 
 
2. Create the “condition” element (4.4.2.7.2 examples from the W3C MathML 

Recommendation) to see how initially invisible (transparent) elements behave. 
 

<condition> 

  <apply><in/><ci> x </ci><ci type="set"> A </ci></apply> 

</condition> 
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At the first glance, the rendering of the document is not changed, but the navigation 

information suggests that the “condition” element is successfully inserted and it is not rendered 
just because there is no presentation for it; the presentation of the “condition” element coincides 
with its contents rendering. 

The changed structure of the document can be viewed using the “nesting view” feature. 
Compare view of the document before insertion of the “condition” element (dashed line around 
the empty input slot): 
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and after it (solid line over the dashed line around the empty input slot): 
 

 
 
This solid line suggests to the thought that there is an internal frame element to hold a 

newly created element of the content markup. 
Now let‟s back to our example and create the “apply” element inside of the “condition” 

element. 
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See the results 
 

 
 

 
 
Arithmetic, Algebra, Logic and Relations 
 
1. Example 4.4.3.9.2 from the W3C MathML Recommendation). 
 

<apply> 

  <times/> 
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  <ci> a </ci> 

  <ci> b </ci> 

</apply> 

 
Press the button on the mathematical toolbar for arithmetic operators or switch the input 

mode to the Content Markup and just press the „*‟ character. 
 

 
 
Type „a‟, press the Right arrow, type „b‟. 
 

 
 
See the results 
 

 
 
Now get back to the “Expression” page and see how to change the appearance of the 

<times/> element. 
The next figures shows which item of menu controls the rendering option of the 

<times/> element. 
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If we select another option (“&InvisibleTimes;”) the appearance of the formula is not 

changed, but the icon  prompts to the need of refreshing the document through MathML (the 
“Refresh All Through MathML” command from the “View” menu). 

 

 
 
After refreshing the formula is rendered as if instead of the <times/> element is used the 

presentation element <mo>&InvisibleTimes</mo>. 
 

 
 
2. Example 4.4.3.4.2 from the W3C MathML Recommendation): Maximum and 

minimum. 
 

<apply> 

  <max/> 

  <ci> a </ci> 

  <ci> b </ci> 

</apply> 
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<apply> 

  <min/> 

  <bvar><ci>x</ci></bvar> 

  <condition> 

    <apply><notin/><ci> x </ci><ci type="set"> B </ci></apply> 

  </condition> 

  <apply> 

      <power/> 

    <ci> x </ci> 

    <cn> 2 </cn> 

  </apply> 

</apply> 
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Here (1) is an expression to be minimized; (2) is an input slot for one bound variable (the 
“bvar” element); (3) a condition element. There is also a button for many bounded variables 

( ) that shows the following dialog: 

 

 
 

This approach is common for all the cases when qualifier elements of the MathML 
content markup are needed. 

Please note that according to the W3C MathML Recommendation the “bvar” element 
should not be rendered in such a content markup element, so we consider it as an invisible (see 
the section “Basic Content Elements: invisible and transparent elements” for detailed 
discussion). This means that the corresponding input slot is available only after insertion of the 
“min” element, because currently rendering of invisible elements is turned off ( ). 

 

 
 
Insert the “apply” element with the <power/> operation. 
 

 
 
Type “x”, “2”. 
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Navigate to the “bar” input slot and type a name of the bounded variable (“x”). 
 

 
 
Create an expression for the “condition” element. 
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Type “x” as a value of the first argument of the “apply” element in the condition; create 

the “ci” element of the “set” type as the second argument of the “apply”. 
 

 
 

 
 
See results on different pages of Formulator 3.7 MathML Weaver. 
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Now get back to the “Expression” page and refresh the document contents through 

MathML. 
 

 
 

 
 
Note that the bounded variable is hided according to the proper rendering of the “min” 

element with condition qualifier. We can edit the bounded variable at any time if we turn on 
rendering of invisible elements and refresh the document through MathML once more. 
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2. Example 4.4.3.17.2 from the W3C MathML Recommendation): universal quantifier 

(forall): 
 

 
 

<apply> 

  <forall/> 

  <bvar><ci> p </ci></bvar> 

  <bvar><ci> q </ci></bvar> 

  <condition> 

    <apply><and/> 

      <apply><in/><ci> p </ci><rationals/></apply> 

      <apply><in/><ci> q </ci><rationals/></apply> 

      <apply><lt/><ci> p </ci><ci> q </ci></apply> 

    </apply> 

  </condition> 

  <apply><lt/> 

      <ci> p </ci> 

      <apply> 
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          <power/> 

        <ci> q </ci> 

        <cn> 2 </cn> 

      </apply> 

  </apply> 

</apply> 

 
The forall element is usually used in conjunction with one or more bound variables, an 

optional condition element, and an assertion. There is lot of available combination of different 
constructs of this element (this is true also for other similar statements, like the “exists” element, 
sums and products, integrals and so on). So MathML Weaver propose several buttons on 
mathematical toolbars, trying to make it faster creating common MathML trees. 

In the case of our example there is the button for the “forall” element with several 

bounded variables and a conditional element: . 

 

 
 

 
 

 
 
Here (1)  and (2) are input slots for two bounded variables; (3) is a condition element; (4) 

is an assertion. 
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Now we should insert the “apply” element with the <and/> operation and three 

arguments. 
 

 
 

 
 

In order to insert the <rationals/> element use the  button: 
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See results on different pages of MathML Weaver. 
 

 
 



Mastering MathML Content Markup  http://www.mmlsoft.com  
 

 58 

 
 
Sequences and Series 
 
1. Example 4.4.7.1.2 from the W3C MathML Recommendation): the sum element: 
 

<apply> 

  <sum/> 

  <domainofapplication> 

    <ci type="set"> B </ci> 

  </domainofapplication> 

  <ci type="function"> f </ci> 

</apply> 

 

 
 
Now it is inserted a visual form for editing the “sum” element with the 

“domainofapplication” qualifier.  
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Input slots below the sum sign are rendered as 

 
in order to allow to a user editing both the bounded variable (the first input slot) and the 

“domainofapplication” element. Leave the first input slot empty and create a “ci” element of 
type “set” for the second input slot. Then create another “ci” element for the argument of the 
“sum” element. 

 

 
 

 
 
Switch to the “MathML Tree” page and delete the node for the bounded variable, since 

the example don‟t need the “bvar” presence. In order to do this, select the “bvar” node and 
press Delete. 
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Then get to the “Expression” and “MathML Text” pages to see results. 
 

 
 

 
 
2. Examples 4.4.7.3.2 from the W3C MathML Recommendation): the limit element: 
 

<apply> 

  <limit/> 

  <bvar><ci> x </ci></bvar> 

  <lowlimit><cn> 0 </cn></lowlimit> 

  <apply><sin/><ci> x </ci></apply> 

</apply> 
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Constructor elements: theory of sets and linear algebra 
 
1. The next example shows how to create elements of the theory of sets. 
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Now create a list using a bounded variable and a condition element (example 4.4.6.2.2 

from the W3C MathML Recommendation): 
 

<list order="numeric"> 

  <bvar><ci> x </ci></bvar> 

  <condition> 

    <apply><lt/> 

      <ci> x </ci> 

      <cn> 5 </cn> 

    </apply> 

  </condition> 

  <ci> x </ci> 

</list> 

 

 
 

 
 
If we recall the case of the minimum operator from the “Arithmetic, Algebra, Logic and 

Relations” section, it will be obvious that the structure of the just created “list” element is quite 
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similar to that case. Namely, the starting input slot is for a rule of constructing list‟s items; after 
the vertical line there is a smaller input slot for a bounded variable; the last input slot is for a 
condition. 

 

 
 

 
 
In order to get proper rendering of the list we should turn off the invisible elements 

rendering and refresh the document through MathML, as it is shown on the next figures. 
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Switch to the “MathML Tree” page to see results. 
 

 
 
2. The next examples shows how to create elements of the linear algebra. 
 

<vector> 

  <cn> 1 </cn> 

  <cn> 2 </cn> 

  <cn> 3 </cn> 

  <ci> x </ci> 

</vector> 
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Press „1‟, the Down arrow, „2‟, the Down arrow, „3‟, the Down arrow, „x‟. 
 

 
 
See results: 
 

 
 
The next example show how to construct a matrix and use the “selector” element. 
 

<apply> 

  <selector/> 

  <matrix> 

    <matrixrow> 

      <cn> 1 </cn> <cn> 2 </cn> 

    </matrixrow> 

    <matrixrow> 

      <cn> 3 </cn> <cn> 4 </cn> 

    </matrixrow> 

  </matrix> 

  <cn> 1 </cn> 
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</apply> 

 

 
 
Press „1‟, the Right arrow, „2‟, the Right arrow, „3‟, the Right arrow, „4‟, the Right arrow. 
 

 
 
Select the whole matrix. 
 

 
 
Insert the “separator” element. 
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Press the Right arrow, „1‟. 
 

 
 
See the resulting MathML tree: 
 

 
 
 
Calculus and Vector Calculus: Integral and Differentiation 
 
1. Example 4.4.5.1.2 from the W3C MathML Recommendation): the int element: 
 

<apply> 

  <int/> 

  <bvar><ci> x </ci></bvar> 

  <lowlimit><cn> 0 </cn></lowlimit> 

  <uplimit><ci> a </ci></uplimit> 

  <apply> 

    <ci> f </ci> 



Mastering MathML Content Markup  http://www.mmlsoft.com  
 

 69 

    <ci> x </ci> 

  </apply> 

</apply> 

 

Use the mathematical toolbar . 

 

 
 
Press „0‟, the Up arrow, „a‟ (a low and upper limits of the integral). 
 

 
 

 
 
Type „f‟, the Right arrow, „x‟. 
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Press the Right arrow two times, type „x‟ (a bounded variable). 
 

 
 
See results: 
 

 
 

 
 
2. Example 4.4.5.2.2 from the W3C MathML Recommendation): the diff element: 
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<apply> 

  <diff/> 

  <bvar><ci> x </ci></bvar> 

  <apply><ci type="function"> f </ci> 

    <ci> x </ci> 

  </apply> 

</apply> 

 

 
 
Type „x‟ (a name of the bounded variable), press the Right arrow. 
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Insert the “ci” element of type “function”; name it “f”. 
 

 
 
Type „f‟, press the Right arrow two times (the first in order to get out of the “ci” node, the 

second to get to the second input slot of the “apply” element). Type „x‟. 
 

 
 
See results: 
 

 
 

 
Partial Differentiation 
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1. The “partialdiff” element can automatically calculate a total degree of differentiation 
by use of child degree elements. The next example demonstrates this feature. 

 

 
 

 
 

 
 
Input names of bounded variables and choose a numeric and symbolic values of their 

degree. 
 

 
 
Now a total degree of differentiation can be calculated if we refresh the text through 

MathML. 
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See results: 
 

 
 
Turn on the “Show Read-Only” option from the “View” menu to see which areas can‟t be 

edited in the created formula. The next figure suggests that automatically detected total degree 
of the “partialdiff” element can‟t be edited (dashed red line around elements). 

 

 
 
See the same results on the “XHTML” page of MathML Weaver, using the „Zoom‟ 

feature from the context menu. 
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2. Example 4.4.5.3.2 from the W3C MathML Recommendation): the partialdiff element: 
 

<apply><partialdiff/> 

 <bvar><ci> x </ci><degree><ci> m </ci></degree></bvar> 

 <bvar><ci> y </ci><degree><ci> n </ci></degree></bvar> 

 <degree><ci> k </ci></degree> 

 <apply><ci type="function"> f </ci> 

  <ci> x </ci> 

  <ci> y </ci> 

 </apply> 

</apply> 
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Input a total degree of differentiation by typing „k‟. Press the Right arrow to start 

inputting bounded variables. 
 

 
 
Press „x‟, the Right arrow, „m‟, the Right arrow, „y‟, the Right arrow, „n‟, the Right arrow. 
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Press „f‟, the Right arrow, „x‟, the Right arrow, „y‟. 
 

 
 
Switch to the “MathML Tree” and add the “type” attribute to the function „f‟. 
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Statistics 
 
Lets‟ consider an example 4.4.9.6.2 from the W3C MathML Recommendation): the 

partialdiff element: 
 

<apply> 

  <moment/> 

  <degree><cn> 3 </cn></degree> 

  <momentabout> 

    <ci> p </ci> 

  </momentabout> 

  <ci> X </ci> 

</apply> 
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Get rid of the input slot for the “momentabout” element (that should not be finally 

rendered). 
 

 
 

 
 
Read-only elements 
 
Create the “variance” element with 5 arguments and see which elements are read-only in 

the visual editing form. 
 
Turn on the “Show Read-Only” option from the “View” menu. 
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See how MathML Weaver make it easy to navigate through the formula by marking 

some MathML nodes as read-only. 
 

 
 
Red dashed line around an element means that this element can‟t be edited, because it is 

an essential part of a visual editing form for some element of the content markup. When a user 
presses navigation buttons (e.g., arrows), MathML Weaver omits visiting every element of the 
form, but rather chooses only not read-only elements. Due to this smart behavior a user can 
navigate through the MathML tree much faster, without positioning on every tree hierarchy 
level and every existing node. 

 
Finish editing the “variance” element and see results. 
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Combining Presentation and Content Markup 
 
MathML Weaver is able to combine Presentation and Content Markup of MathML in 

three ways: 
 
1. Presentation elements can be inserted into the input slots of editing form of the content 

markup. When the presence of such combining seems inappropriate by W3C Recommendation, 
presentation elements are wrapped into the “csymbol” an element, because MathML Weaver 
consider such cases as definition on-the-fly of an element in MathML whose semantics are 
externally defined. 

 
2. The simplest way how content markup can be contained in presentation markup is just 

simultaneously using the Presentation and Content mathematical toolbars, thus embedding 
content markup nodes into the existing presentation hierarchy of elements. Note that the 
resulting expression should still have an unambiguous rendering. 

 
An example from the 5.2.1 section of the W3C Recommendation. 
 

<mrow> 

  <apply> 

    <power/> 

    <ci>x</ci> 

    <cn>2</cn> 

  </apply> 

  <mo>+</mo> 

  <msup> 

    <mi>v</mi> 

    <mn>2</mn> 

  </msup> 

</mrow> 

 
Switch to the Content MathML input mode. 
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Type „^‟ to insert the “apply” element with the <power/> operation. 
 

 
 
Press „x‟, the Right arrow, „2‟. 
 

 
 
Switch to the Presentation MathML input mode; type „+‟. 
 

 
 
Press the Right arrow to get out of the “apply” element; using presentation toolbar insert 

the superscript MathML node. 
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Press „v‟, the Right arrow, „2‟. 
 

 
 
See the resulting MathML tree and text. 
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3. By using Semantic Mapping Elements from the  toolbar content markup can be 

contained in presentation markup as a Parallel Markup, thus making use of both presentation 
and content information for the same element. 

 
Insert the “semantics” element. 
 

 
 
Its rendering can‟t be correct right away, since a user should input needed values of child 

“annotation” elements. 
 

 
 
Create “sin(x) + 5” expression using different markups. 
 

 
 
Refresh appearance of the document. 
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See results on different pages of MathML Weaver. 
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